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MicroStation Tutorials

Die folgenden Tutorials sollen Ihnen Grundkenntnisse über MicroStation und seine einfachsten Be-
fehle vermitteln, damit Sie sich danach auf den Inhalt des Kurses konzentrieren können, der diese
Grundkenntnisse voraussetzt.

MicroStation ist ein weltweit verbreitetes "general purpose" CAD-System. Es gibt für MicroStation
verschiedene Erweiterungen für den Architekturbereich, aber auch für das Ingenieurwesen und für
geographische Anwendungen, die sich in das Programm integrieren lassen. Einige solcher Erweite-
rungen werden Sie in diesem Semester kennenlernen. Allerdings ist der Hauptfokus dieses Seme-
sters, die Grundprinzipien des Modellierens mit CAD zu erlernen. Die meisten der Funktionen und
Operationen, die Sie bei der Arbeit mit MicroStation kennenlernen werden, gehören denn auch
zum Funktionsumfang üblicher CAD Programme.

Bei der deutschen Einweisung in ein englisches Programm stellt sich immer das Problem der Wort-
wahl. Wir verwenden in den Tutorials zumeist die englischen Begriffe, die man auch auf der Benut-
zeroberfläche antrifft. Dies ist sprachlich nicht sehr befriedigend, aber insgesamt doch weniger ver-
wirrend. Soweit wir das für nötig halten, werden Begriffe erläutert, wenn sie das erste Mal verwen-
det werden. Häufig verwendete Begriffe werden nur das erste Mal in Anführungszeichen gesetzt.
Im Übrigen sei auf das Glossar, am Ende dieses Skripts, verwiesen, in dem viele im CAD Bereich üb-
liche Begriffe erklärt werden.

Folgende Konventionen wurden befolgt:

Menunamen und Begriffe in Dialogboxen werden in Anführungszeichen gesetzt.
Submenus werden durch die "grösser als" - Taste (">") angegeben, zum Beispiel

Menu: "File" > "Compress Design"

Befehle werden kursiv gedruckt. In vielen Fällen ist daneben noch das Icon abgebildet.
Der kursive Text könnte aber auch in der sogenannten "key-in" Kommandozeile ein-
getippt und mit RETURN abgeschlossen werden:

update view

Spezielle Tasten werden in Grossbuchstaben angegeben:

ESC ist die Escape-Taste, SPACE die Spacetaste.
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MicroStation I

In diesem ersten Tutorial lernen Sie zunächst die graphische Benutzeroberfläche von MicroStation
kennen. Danach werden die grundsätzlichsten Operationen für das Arbeiten in 2D vorgestellt.

Die graphische Benutzeroberfläche von MicroStation ist, obwohl sie viele graphische Icons auf-
weist, nicht unbedingt selbsterklärend. Ihre grosse Stärke ist ihre Flexibilität. Als User kann man sich
seinen "Workspace" einrichten, je nach Aufgabe mehr oder weniger "Toolboxes" öffnen und plazie-
ren. Damit man sich nicht in der Fülle der Möglichkeiten verliert, muss man ein paar grundsätzli-
che Konzepte stets im Auge behalten, die in diesem Tutorial vorgestellt werden.

Es werden die wichtigsten Konstruktionstools und die Zeichnungshilfen beschrieben, die nicht nur
für die hier eingeführten Zeichenbefehle nützlich sind, sondern ganz allgemein das Editieren in
Microstation erleichtern.

MicroStation basiert auf dem karthesischen Koordinatensystem. Wenn das System vom Benutzer
eine Eingabe bezüglich der Position oder einer Auswahl von Elementen verlangt, werden entweder
die absoluten x-, y- und z-Koordinaten eines Punktes akzeptiert oder die Polarkoordinaten relativ zu
einem existierenden Punkt. Es gibt verschiedene Möglichkeiten, diese Information dem System zu
übermitteln. Der Benutzer kann einen Punkt interaktiv mit der Maus auf dem Bildschirm selektie-
ren, die Koordinaten mit der Tastatur eingeben, oder die relative Position des neuen Punktes einge-
ben. Eine Spezialität von MicroStation ist AccuDraw, der intelligente Cursor, mit dem die Eingabe
von Punkten relativ zu einem bestehenden Modell erleichtert wird. AccuDraw wird in diesem
Tutorial ausführlich vorgestellt.

Eine MicroStation Datei heisst "Design File" (filename.dgn). Um Informationen in einem Design File
besser organisieren zu können, bietet MicroStation ein "Level"-System an (in anderen CAD Pro-
grammen Layers genannt). Levels können mit Schichtplänen, oder übereinandergelegten, transpa-
renten Zeichnungen verglichen werden. Jede graphische Information in einem MicroStation De-
sign File ist einzelnen Levels zugeordnet. Die Levels können, je nachdem welche Information zu ei-
nem bestimmten Zeitpunkt bearbeitet wird, entweder unsichtbar oder sichtbar gestellt werden.

Befehle werden in MicroStation normalerweise graphisch, mittels dem entsprechenden Icon ange-
wählt. Sie können aber auch direkt über die Tastatur, als sogenannte "key-ins" eingegeben werden.
Für einen angewählten Befehl steht häufig eine Dialogbox mit Optionen zur Verfügung. In der
Statuszeile, links unten, wird ausserdem angezeigt, welche Eingabe als nächstes erfolgen soll. Aus-
geführt werden die meisten Befehle aber erst, wenn man in das Zeichenfenster klickt, in dem der
Befehl ausgeführt werden soll.

Wenn Sie im Tutorial aufgefordert werden, etwas einzugeben, tippen Sie die Buchstaben und/oder
Zahlen ein, die sich zwischen den "[" und "]" Zeichen befinden. Jede Eingabe muss mit der RETURN
Taste abgeschlossen werden. Zusätzliche RETURNs werden explizit erwähnt. Es kann vorkommen,
dass Sie einen Befehl abbrechen möchten, um einen neuen Befehl beginnen zu können. Sie tun
dies, indem Sie mit der rechten Maustaste ("reset") klicken, oder, falls Sie einen anderen Befehl ver-
wenden wollen, indem Sie direkt auf das neue Icon klicken.
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MicroStation Modell kopieren

wo Home Directory Fenster
was Den Ausgabe-Folder doppelklicken. Selektieren Sie das Icon für ms_1.dgn, schieben Sie

es vom Ausgabe-Directory ins Tutorials-Directory (im Home-Directory Fenster). Klicken
Sie auf den Copy-Knopf im erscheinenden "File Manager Information" Fenster. Dann
öffnen Sie das Tutorials-Directory und benennen Sie das File in a1_nachname.dgn um.

bem Schreiben Sie alles klein, mit Unterstrich statt Leerstelle und mit der Endung ".dgn", damit MicroStation das File wiedererken-
nen kann. Überall wo "nachname" geschrieben ist oder verlangt wird, ist Ihr eigener Nachname einzusetzen. Filenamen mit
grossen Buchstaben können Probleme verursachen.

MicroStation starten

wo Tutorials Directory Fenster

was a1_nachname.dgn doppelklicken. Automatisch wird MicroStation mit der Zeichnung
a1_nachname.dgn aufgestartet.

bem Um ein neues (leeres) File in MicroStation zu starten, wählen Sie im Menu "File" die Option "New". Es erscheint ein Fenster, in
dem der Name der neuen Zeichnung (ohne Endung .dgn) angegeben werden kann. Passen Sie auf, dass die Zeichnung in das
richtige Directory gespeichert wird: der Pfad muss richtig eingestellt werden.

Der Arbeitsplatz

Um mit MicroStation effizient zu Arbeiten, empfiehlt es sich den Arbeitsplatz so einzurichten, dass
die gebräuchlichsten Funktionen einfach aufgefunden und gebraucht werden können.
Beim erstmaligen öffnen einer neuen Zeichnung werden nur die drei wichtigsten Toolboxes gela-
den. Es sind dies die Primary-, Standard- und die Main Toolbox, welche auf der linken Seite Ihres
Arbeitsfensters, direkt unterhalb des Menus "angedockt" sind.

wo Menu: "Tools" > "Main"
was Indem Sie die gewünschten Optionen aktivieren, können die betreffenden Toolboxes

eingeschaltet werden. Für die erste Übung benötigen Sie folgende Tools:
"Manipulate", "Modify" und "Linear Elements"

Um Platz zu sparen, können Sie die neu geöffenten Toolboxes an den linken Rand Ihres
MicroStation Fensters schieben, damit sie dort "angedockt" werden.

bem Unter "Tools" > "Tool Boxes" finden Sie eine Zusammenstellung aller von MicroStation zur Verfügung gestellten Toolboxes.
Indem Sie auf die gewünschten Namen klicken, können die einzelnen Tools ein- oder ausgeschaltet werden.

VIEW CONTROL: Bildschirminhalt verwalten

Wenn die Zeichnung am Bildschirm nach längerem Arbeiten "verunstaltet" wurde, können Sie mit
dem Update View Befehl den Zeichnungsinhalt auf dem Bildschirm neu darstellen lassen. Mit
Window Area habenSie die Möglichkeit einen Ausschnitt Ihres Arbeitsfensters zu vergrössern, falls
Sie hingegen alle Elemente Ihrer Zeichnung sehen wollen, können Sie die Funktion Fit View verwen-
den. Der Befehl Pan View verschiebt den dargestellten Ausschnitt der Zeichnung.
Alle diese Befehle können direkt aus der Panoramaleiste Ihres Arbeitsfensters aktiviert werden.

wo Panoramaleiste View Control

was Update View anklicken

Window Area anklicken

Fit View anklicken

Pan View anklicken
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GRID, Raster und Fangmodus einschalten

Das Grid ist eine optische Hilfsfunktion, welche aus einem in die Zeichnungsebene projizierten
Punktraster besteht. Es kann während dem Arbeiten einen gewissen Eindruck über die verwende-
ten Zeichnungseinheiten und über die Ausrichtung der gezeichneten Objekte geben.

was Als erstes werden Sie die Rastereinheit definieren
wo Menu: "Settings" > "Design File..."

Dialogbox: "Design File Settings":
Category Grid anwählen.
Grid Master: 0.5
Grid Reference: 2
OK

was Damit der Raster auf dem Bildschirm angezeigt wird, müssen Sie ihn einschalten.
wo Menu: "Settings" > "View Attributes"
was Aktivieren Sie in der Dialogbox "View Attributes" die Option Grid und bestätigen mit

"Apply".  Schliessen Sie die Dialogbox.
bem In der "Locks" Dialogbox, welche Sie unter"Settings">"Locks">"Full" finden, haben Sie die Möglichkeit einen Grid Lock

einzuschalten.  Bei eingeschaltetem Grid Lock können nur noch Datenpunkte ausgewählt werden, welche exakt mit dem Grid
zusammenfallen. Diese Option kann sehr hilfreich sein, wenn sie ein Objekt konstruieren, welches auf einem Raster aufgebaut
ist.

Durch klicken auf das Icon "Sperren" in der Statusleiste, erlangen sie direkten Zugriff auf das Untermenu "Locks", in
welchem sie den Grid Lock ein- oder ausschalten können.

AccuDraw

AccuDraw stellt eines der wichtigsten Tools innerhalb von MicroStation dar. Es ist eine Zeichnungs-
hilfe, welche die präzise Eingabe von Datenpunkten erleichtert.

was Klicken Sie in der Toolbox "Primary Tools" auf das Icon  für AccuDraw.

Es erscheint ein Koordinatendisplay, welches Sie am unteren Rand Ihres
MicroStation Fensters andocken sollten.

Wählen Sie unter "Settings" > "AccuDraw".
Es erscheint ein Fenster mit den AccuDraw Settings. Wählen Sie "Shortcut
Key Ins" und schliessen Sie das Settings Fenster.

 bem Weitere Informationen über AccuDraw und dessen Gebrauch finden Sie in der nachfolgenden Dokumen-
tation.

Fangmodus

AccuDraw bietet sogenannte "Tentative Points" an (dt.:vorgeschlagene oder Versuchspunkte).
Damit aber die von AccuDraw vorgeschlagenen Punkte die erwarteten Bedingungen erfüllen, muss
die Auswahl der Punkte eingeschränkt werden. Dies geschieht durch das Festlegen eines Fang-
modus, welcher die Beziehung zwischen einem vorgeschlagenem Punkt und dem dazugehörigen
Objekt festlegt.

was Öffnen sie die Toolbox "Snap Mode" und
docken Sie diese am unteren Rand Ihres
MicroStation Fensters an.

wo Menu: "Settings">"Snaps" > "Button Bar"

Für dieses Tutorial sollte der Modus auf Keypoint (Eigenpunkt)  eingestellt sein.
bem Der aktuelle Fangmodus (oder die Fangmodus-Korrektur) wird auf der rechten Seite in der Statusleiste angezeigt.

Weitere Informationen über das Arbeiten mit Tentative Points finden Sie ebenfalls in der nachfolgenden Dokumentation.
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Speichern der Settings

Während dem Arbeiten mit MicroStation, wird jeder ausgeführte Schritt automatisch gespeichert.
Die Settings-Variablen werden hingegen erst beim Verlassen von MicroStation in einem seperatem
File gespeichert. Beim nächsten Start von MicroStation, werden Sie Ihren Arbeitsplatz genauso vor-
finden, wie Sie ihn verlassen haben.

Sie können diese Settings aber auch Manuell abspeichern.

wo Menu: "File" > "Save Settings".
was Damit haben Sie die Änderungen der Settings wie Grid Einstellung, offene Toolboxes etc.

gespeichert. Beim nächsten Start werden alle von Ihnen geöffneten Toolboxes wieder
angezeigt.

bem Es ist somit von Vorteil, sich den Arbeitsplatz einmal einzurichten und ihn zu speichern.

Arbeitsplatz:

Wenn Sie nun beginnen mit MicroStation zu arbeiten, sollte Ihr Arbeitsplatz folgendermassen  aus-
sehen:

COPY: Einfaches kopieren

Benützen Sie den COPY-Befehl, um das obere linke Muster mit den vier unten vorgegebenen Ele-
menten nochmals im Copy-Raster herzustellen.
Es empfiehlt sich an dieser Stelle, die nachfolgende AccuDraw Dokumentation zu lesen, da diese
für die weitere Arbeit benötigt wird.

wo manipulate Toolbox

wie copy  anklicken:

Klicken Sie mit der mittleren Maustaste auf die rechte untere Ecke des Elementes und
bestätigen Sie mit der linken Maustaste. Mit der mittleren Maustaste snappen Sie in die
rechte untere Ecke des Copy-Rasters - bestätigen sie mit der linken Maustaste. Schliessen
Sie den Befehl mit der rechten Maustaste ab. Üben Sie diesen Vorgang, bis das Muster
fertig ist.

bem Mit "ctrl select" können Sie mehrere Elemente auswählen, wenn Sie ein Element ein zweites Mal anklicken, wird es wieder
deselektiert. Um alles zu selektieren, wählen Sie im Menu "Edit" "Select All".
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DELETE ELEMENT: Objekte löschen

Wenn man Elemente zu oft kopiert hat, gibt es die Möglichkeit sie zu löschen.

wo main toolbox

wie delete element anwählen, mit der linken Maustaste Elemente anklicken
und zum Abschliessen der Funktion mit der linken Maustaste in den
Hintergrund des Arbeitsfensters klicken.

bem Anstatt über das Icon, können Sie auch die DELETE Taste auf Ihrer Tastatur verwenden, nachdem Sie die
Elemente mit Select ausgewählt haben.

UNDO und REDO

Während dem Arbeiten mit MicroStation haben Sie jederzeit die Möglichkeit, die zuletzt ausgeführ-
ten Befehle rückgänig zu machen. Dies ist desshalb möglich, weil MicroStation alle Schritte die Sie
ausführen speichert. Gleichzeitig könne Sie die mit Undo rückgängig gemachten Aktionen mit Redo
wieder herstellen.

wo Standard Toolbox

was undo und redo anklicken.

bem In der Panoramaleiste (View Control) des Arbeitsfensters finden Sie die gleichen Undo/Redo Icons wie in der Standard Toolbox.
Diese Icons unterscheiden sich aber grundlegend voneinander, da die Funktionen der Panoramaleiste nur die Darstellung des
Fensterinhaltes betreffen und keinen Einfluss auf das Modell selbst haben .

COMPRESS: Speicherplatz und Modell optimieren

Wenn man in MicroStation ein Element gelöscht hat, wird es nicht entfernt, sondern als gelöscht
markiert. Das ermöglicht die Undo Funktion. Das Komprimieren der Zeichnung erreicht ihre Ver-
kleinerung, indem die als gelöscht markierten Elemente wirklich entfernt werden. Danach ist die
Undo Funktion nicht mehr verfügbar.

wo Menu: "File" > "Compress Design"

MOVE: Verschieben eines oder mehrerer Elemente

Mit move können Sie eines oder mehrere Elemente verschieben oder auch eine Kopie der Elemente
verschieben.

wo manipulate Toolbox

wie move   anklicken

Klicken Sie mit der mittleren Maustaste auf einen Referenzpunkt des Elementes (ein
Eckpunkt), bestätigen Sie den Punkt mit der linken Maustaste und geben Sie mit der
mittleren Maustaste den Zielpunkt ein, an dem das Objekt eingesetzt werden soll.
Bestätigen Sie wieder und schliessen Sie den Befehl mit der rechten Maustaste ab.

bem Falls Sie den Punkt, den Sie mit der mittleren Maustaste angewählt haben, nicht akzeptieren wollen, benutzen Sie die rechte
Maustaste um die Wahl zu negieren. Jetzt können Sie mit der mittleren Maustaste einen neuen Punkt anwählen.
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LEVELS: Level unsichtbar

Sie werden jetzt die Ebene, auf der sich das Muster befindet, unsichtbar machen. Sie haben dann
eine bessere Übersicht, wenn Sie den fehlenden Raster zeichnen.

wo "Setting"> "Level"> "Display"

wie In der Dialogbox "View Level"

klicken Sie auf die Zahl 2. Das schwarze Quadrat verschwindet.
Damit ist die Ebene 2 jetzt unsichtbar. Klicken Sie zuerst auf Apply und danach auf
Update View

bem Plazieren Sie die Dialogbox "View Level" so, dass sie Sie beim Zeichnen nicht stört.

Smart Line zeichnen

Nun werden wir den fehlenden Raster zeichnen. Zu diesem Zweck werden wir die Tools smartline
und line benutzen.

was Wählen Sie in der Main-Toolbox das Icon für Linienelemente, halten Sie die Maustaste
gedrückt und ziehen Sie sie in die Mitte ihres Fensters. Falls Sie in der Main-Toolbox das
Icon nicht finde, so selektieren Sie unter "Tools">"Main" "entweder die Option
"Architecture" oder "Linear Elements". Wenn Sie die Maustaste jetzt loslassen, erscheint
eine Child-Toolbox für lineare Elemente. Die Aussenkanten der fehlenden Rasters werden
Sie zuerst mit Hilfslinien zeichnen. Die Eckpunkte des bestehenden Raster dienen dabei
als Referenzpunkte.

wo linear elements toolbox

wie wählen Sie das Icon place smartline und  deaktivieren
Sie in der erscheinenden Toolbox die Option "Join
Elements".

Klicken Sie mit der mittleren Maustaste in die obere rechte Ecke des bestehenden ersten
Rasters und bestätigen Sie den Punkt mit der linken Maustaste. Klicken Sie jetzt mit der
mittleren Maustaste auf die linke obere Ecke des zweiten bestehenden Rasters und
bestätigen sie mit der linken Maustaste. Schliessen sie die Eingabe mit der rechten
Maustaste ab. Zeichnen Sie die zweite horizontale Begrenzungslinie analog.
Da Sie für die vertikalen Linien nur die Referenzpunkte des mittleren Rasters haben,
wählen Sie diese mit der mittleren Maustaste und akzeptieren Sie wiederum mit der
linken Maustaste. Jetzt können Sie im Koordinatendisplay die x-Achse auf 0 setzten und
sperren, damit werden die zwei letzten Linien des Rasters auch wirklich vertikal. Zeich-
nen Sie die Linien so, dass sie über die unteren horizontalen Begrenzungslinien reichen.

bem Die Funktion Place Smartline bleibt solange aktiv, bis Sie eine andere Funktion oder Select  wählen. Dies gilt für die
meisten Befehle.
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Smart Line kürzen

In einem weiteren Schritt müssen wir die gezeichneten Kanten auf die richtige Länge kürzen.

wo modify

wie Wählen Sie das Icon Extend Elements to Intersection ,
klicken Sie nacheinander auf die zwei Linien die Sie
kürzen wollen, und zwar jeweils in dem Bereich der nachher sichtbar sein soll. Die zwei
Linien werden jetzt auf den Eckpunkt gekürzt. Mit der linken Maustaste können Sie den
Befehl erneut aufrufen, mit der rechten Maustaste können Sie den Befehl rückgängig
machen.
Wenn Sie alle Linien gekürzt haben, klicken sie wieder auf das Select Icon

bem Kontrollieren Sie mit Update View, ob Sie auch alle Linien gekürzt haben.

Mehrfaches Kopieren

Um das vertikale Raster fertig zu zeichnen, benutzen Sie die array Funktion in der Toolbox
"manipulate".

wo manipulate

wie Starten sie die array Funktion  und machen Sie folgen-
de Eingaben:
active angle = 0°
rows = 1
columns = 4
row spacing = 1
column spacing =2
markieren Sie die rechte Kante ihres Rasters und bestätigen sie mit der linken Maustaste.
Schliessen Sie die Funktion, indem Sie das Select Icon anklicken.

bem Wenn Sie ein Array nach unten oder nach rechts erstellen wollen, müssen Sie bei spacing eine negative Zahl
eingeben.

Snap Divisor

Um den horizontalen Teil des Rasters zu zeichnen, verwenden wir eine weitere hilfreiche Funktion
des AccuDraw. Mit Hilfe des snap divisors können Sie eine Linie in gleich grosse Abschnitte untertei-
len, d.h. Sie setzen damit weitere Eigenpunkte auf die Linie, welche die Linie in gleichgrosse Ab-
schnitte unterteilen. Diese können Sie nun, z. B. für die Funktion Place Line, als präzisen Anfangs-
punkt verwenden.

wo AccuDraw Shortcuts

wie Suchen Sie die Funktion Snap Divisor und starten sie mit run. Eine Dialogbox wird geöff-
net, in der Sie die Anzahl der Keypoints eingeben können. Geben sie [4] ein und bestäti-
gen Sie mit der Return Taste.

bem Nachdem Sie die Funktion gestartet haben, wird jede Linie, die Sie anklicken, automatisch in vier gleichgrosse Abschnitte
unterteilt.

Sie können den Befehl ebenfalls Starten, indem Sie auf der Tastatur den dazugehörigen Shortcut eingeben - in diesem Fall "k".
Auf diese Weise können sie die meisten AccuDraw Funktionen über die Tastatur aufrufen.
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Linie zeichnen

Für die restlichen horizontalen Linien des Rasters verwenden Sie die Funktion Place Line.

wo linear elements

wie Wählen Sie das Icon Place Line ,
ein Fenster wird geöffnet.

Geben Sie die Länge [8] und den Winkel [0°] ein. Wenn Sie auf die kleinen Fenster neben
den Zahlenwerten klicken, sind die Daten gelockt. Klicken Sie mit der mittleren Maus-
taste in das obere Viertel der linken vertikalen Begrenzungslinie. Das Fadenkreuz springt
automatisch auf den ersten Keypoint, den sie mit dem Snap Divisor gesetzt haben.
Bestätigen Sie den Punkt mit der linken Maustaste. Wählen Sie analog die restlichen zwei
Punkte. Wenn Sie die drei horizontalen Linien gezeichnt haben, schliessen Sie den Befehl
mit der rechten Maustaste ab.

LEVELS: Level sichtbar

wo Dialogbox "View Levels"
wie Klicken Sie auf die Zahl 2, sie wird jetzt wieder mit einem schwarzen Quadrat markiert,

bestätigen Sie mit "apply" - das Muster ist jetzt wieder sichtbar. Schliessen Sie die Dialog-
box.

Copy

Jetzt da alle Raster vorhanden sind, werden Sie darin den Rest der vorgegebenen Muster mit den
vorhandenen Elementen rekonstruieren. Als erstes soll das rote Quadrat kopiert werden und in den
Rotate-Raster eingefügt werden. Anstatt mit den Funktionen copy und move zu arbeiten, benutzen
Sie diesmal nur die move-Funktion.

wo manipulate

wie Wählen Sie den Befehl move, ein Fenster erscheint.

Klicken Sie auf das Kästchen "make copy". Klicken Sie nun mit der mittleren Maustaste
auf die linke obere Ecke des roten Quadrates, bestätigen Sie mit der linken Maustaste.
Klicken Sie nun mit der mittleren Maustaste auf die linke obere Ecke des Rasters, bestäti-
gen Sie mit der linken Maustaste, schliessen sie mit der rechten Maustaste ab.
KopierenSie analog das zweite Quadrat.

Rotate

Um das T und das U zu zeichnen wenden wir die zwei Befehle move und rotate an.

wo "Tools" > "Main" > "Manipulate"
wie Erstellen Sie zuerst eine Kopie der T-Figur, wobei die obere rechte Ecke

der Figur in der Mitte der unteren Rasterbegrenzungslinie zu liegen
kommen sollte.
Schliessen Sie den copy Befehl mit der rechten Maustaste ab.

Klicken Sie nun auf das rotate Icon  in der Manipulate Toolbox und
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selektieren Sie mit der mittleren Maustaste die rechte obere Ecke des soeben kopierten
Elementes. Bestätigen Sie Ihre Selektion mit der linken Taste. Geben Sie einen Winkel von
270° ein und bestätigen Sie den Punkt mit einem Linksklick.
Beenden Sie den Befehl mit der rechten Maustaste.

Gehen Sie bei der U-Form analog vor und kopieren die Form so, dass Sie als Rotations-
punkt die rechte obere Ecke des Rasters erhalten.

bem Falls Sie um einen anderen Punkt drehen möchten, snappen Sie mit der mittleren Maustaste auf den gewünschten Punkt und
bestätigen Sie mit der linken Maustaste.

Mirror

Um das letzte Muster zu zeichnen, wenden wir den Mirror Befehl an.

wo manipulate

wie Kopieren Sie zuerst die blaue L-Form in das Raster, wobei die untere linke Ecke des
Objektes auf der unteren linken Ecke des Raster zu liegen kommt.
Aktivieren Sie den mirror Befehl in der Manipulate Toolbox und selektieren anschliessend
die rechte untere Ecke des kopierten Objektes mit der mittleren Maustaste (AccuDraw).
Bestätigen Sie mit der linken Maustaste die Selektion.
In der Mirror Settings Dialogebox wählen Sie nun die Option Mirror About: Vertical und
belassen die übrigen Optionen unselektiert. MicroStation fordert Sie nun auf, einen
Punkt der "vertikalen" Spiegelachse anzugeben. Selektieren Sie dazu nochmals die rechte
untere Ecke des Objektes, bestätigen Sie die Auswahl mit einem Linksklick und beenden
die Funktion mit der rechten Maustaste.

Selektieren Sie nochmals das blaue Objekt mit der linken Taste, stellen in der Mirror
Settings Dialogebox den Wert für Mirror About auf Line ein und selektieren die Option
Make Copy.
Sie werden nun aufgefordert mittels zwei Punkten die Spiegelachse zu definieren. Selek-
tieren Sie dazu zuerst die linke untere Ecke des Rasters mit der mittleren Taste und
bestätigen den Punkt mit einem Linksklick. Als zweiten Punkt geben Sie die rechte obere
Ecke des Rasters an und verfahren gleich wie vorhin.
Nachdem Sie die Spiegelachse definiert haben, müssen Sie den mirror Befehl mit der
rechten Maustaste abschliessen.
Vervollständigen Sie nun selbstständig das Raster entsprechend dem Vorgabemuster.

Image

Abspeichern von Bildern

wie Wählen Sie unter "Utilities" > "Image" "Save". Das Fenster "Save Image" wird geöffnet.
Wählen Sie
Format = "TIFF (compressed)"
Shading = "Wireframe"
Lassen Sie alle anderen Einstellungen gleich. Klicken SIe auf "Save..."
Speichern Sie das Bild als a1_nachname.tif ab.

bem Die Bilder werden automatisch in in einem Subfolder Ihres Working Directories, namens "image", plaziert. Falls kein solcher
besteht, wird er von MicroStation angelegt.

MicroStation beenden

wie Wählen sie unter "File" "exit".
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AccuDraw Dokumentation
AccuDraw stellt eines der wichtigsten Tools innerhalb von MicroStation dar.
Es handelt sich dabei um eine Zeichnungshilfe, welche anhand verschiedener Parametern, wie z.B.
der aktuellen Zeigerposition, dem zuletzt eingegebenen Datenpunkt, den letzten Koordinatenan-
weisungen und den aktuellen Funktionsanforderungen, die entsprechenden Präzisionskoordinaten
generiert. Der Benutzer hat die Möglichkeit, diesen "Vorschlag" innerhalb der aktuellen Funktion zu
verwenden, oder sich einen weiteren Datenpunkt vorschlagen zu lassen.

AccuDraw starten

was Falls Sie AccuDraw noch nicht gestartet haben, können Sie in der "Primary
Tools" Toolbox auf das Icon für AccuDraw klicken.
Richten Sie Ihren Arbeitsplatz wie im vorhergehenden Tutorial beschrieben ein.

Diese Dokumentation ist eine step-by-step Anweisung zum besseren Verständnis von AccuDraw.
Beachten Sie vorallem die Zusammenhänge zwischen dem Cursor im Zeichenfenster und den au-
tomatischen Veränderungen im AccuDraw Fenster.

Linie zeichnen.

wo Ein Linientool auswählen und mit der
linken Maustaste in das Zeichenfenster
klicken.

was Es erscheint der AccuDraw Cursor und ein
RubberBand, an welchem die Maus hängt.

bem Beachten Sie, dass der Cursor im AccuDraw Fenster an die
entsprechende Stelle springt, wenn sie die Maus mehr in x
oder in y- Richtung verschieben.

was Stellen Sie nun den Cursor so, dass das "x"
Textfeld im AccuDraw-Window aktiviert ist.

Gerade Linie mit bestimmter Länge zeichnen

wo Tastatureingabe im "x" Textfeld des
AccuDraw Window.

was Tippen sie die gewünschte Länge ein.
Die Cursorposition bestimmt die Richtung
und der eingetippe Wert dem relativen
Abstand paralell zur x-Achse (z.B. 3).

bem Danach ist die x Richung eingegeben und der Wert gelockt (der Button neben dem Eingabe Feld ist selektiert). Zum Lösen
dieser Bestimmung einfach auf den gelockten Button klicken.

Was Einmal links klicken, um die Eingabe des Datenpunktes zu bestätigen.
bem AccuDraw ist nun bereit für die nächste Eingabe. Um den Linienbefehl endgültig abzuschliessen, klicken sie einmal mit der

rechten Maustaste in den Hintergrund.
Durch Eintippten von [ o ] können sie den "Origin" des AccuDraw Cursors an die aktuelle Position des Mauszeigers verschieben.
Auf diese Art können sie Datenpunkte festlegen, welche Sie sonst nur mittels komplizierten Hilfskonstruktionen erreichen.
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Die Bedienung von AccuDraw folgt immer demselben Schema. Mit der Maus geben sie die grobe
Richtung vor (bzw. wählen Sie ein Eingabefeld im AccuDraw Fenster) und mit der Tastatur bestim-
men Sie die genauen Werte. Bevor Sie die Eingabe mit dem linken Mausklick bestätigt haben, sind
nur die Freiheitsgrade bestimmt, hinter deren Feld der "locked" Button erscheint.

Schiefe Linie

Was Zeichnen Sie mit AccuDraw eine Linie, die
schräg in der Fläche liegt.

Was Danach erscheint ein gedrehter AccuDraw
Cursor, der die orthogonalen Richtung zur
letzten Richtung vorschlägt. Falls Sie in
dieser Richtung fortfahren möchten,
hängen Sie einfach die nächste Linie an.

bem Beachten Sie, dass die Koordinaten im AccuDraw Fenster
immer relativ zum gezeigten Cursor zu verstehen sind.

Was Wenn Sie im Globalen orthogonalen
System weiterzeichnen wollen tippen Sie
[t] ein. Der AccuDraw Cursor wechselt in
die "top" Position.

Fangmodus

Beim arbeiten mit AccuDraw gibt es die Möglichkeit einen bestimmten Punkt auf einem Objekt ex-
akt anzuwählen. Damit aber AccuDraw den richtigen Tentative Point vorschlagen kann, muss zuerst
die Eigenschaft des gesuchten Punktes genauer definiert werden (z.B der Endpunkt einer Linie oder
das Zentrum eines Kreises). Dieser Fangmodus kann in der Toolbox "Snap Mode", welche sich am
unteren Rand Ihres MicroStation Fensters befindet, eingestellt werden.

wo In der "Button Bar", am unteren Rand des
MicroStation Fensters.

was Stellen Sie den Fangmodus auf "Keypoint" ein (Eigenpunkt).

Wenn man mit der mittleren Maustaste im Zeichnungsfenster in die Nähe eines Objektes
klickt, bietet AccuDraw automatisch einen Tentative Point (Versuchspunkt) an. Man hat
die Wahl, diesen Vorschlag entweder zu akzeptieren, indem man den Datenpunkt mit
der linken Maustaste bestätigt, oder sich einen anderen Punkt vorschlagen zu lassen,
indem man nochmals auf die mittlere Maustaste klickt.

bem Wenn die Fangfunktionssperre per default auf Keypoint eingestellt ist und Sie einen Tentativpunkt auf, oder in der Nähe eines
Elements eingeben, wird der nächstgelegene Eigenpunkt eines Elementes "gesnapt".
Wenn die Fangfunktionssperre aktiviert ist, wird durch den Fangmodus bestimmt, wie ein Element von einem Tentativpunkt
gefangen wird.
Der aktuelle Fangmodus wird rechts in der Statusleiste angezeigt.
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Arbeiten mit Tentativpoints

was Mit der mittleren Maustaste in die Nähe eines Elementes klicken. Das Fadenkreuz "snapt"
sofort einen Eigenpunkt des Elementes.

bem Bei einem Tentativpunkt handelt es sich um eine Art der graphischen Eingabe. Tentativpunkte werden für folgende Aktionen
verwendet:

- Vorschau auf die Position des nächsten Datenpunkts. Durch das Akzeptieren des Tentativpunkts mit der linken Maustaste,
wird die Position des Datenpunkts an der Position des Tentativpunkts eingegeben.

- Definieren eines Referenzpunktes zur Eingabe des nächsten Datenpunkts.
Falls Sie den Punkt, den Sie mit der linken Maustaste angewählt haben, nicht akzeptieren wollen, benutzen Sie die rechte
Maustaste um die Wahl zu negieren. Jetzt können Sie mit der mittleren Maustaste einen neuen Punkt anwählen.

AccuDraw konfigurieren:

Was AccuDraw verfügt über eine Vielzahl von Funktionen, die der Benutzer je nach Bedarf
selbst konfigurieren kann.

Wo Im Menu: "Settings" > "AccuDraw"
Wie Im folgenden werden die einzelnen Optionen des AccuDraw-Settings Fenster von Oben

nach unten besprochen. Es ist erforderlich, die verschiedenen Kombinationen selber
auszuprobieren, da nicht alle Kombinationen hier besprochen werden können.

Unit Roundoff

Was Bestimmt die Rundungsgrössen für die entsprechenden Dimen-
sionen

Coordiante System

Was Rotation: Bestimmt die Ausrichtung des AccuDraw Hilfs-
koordinatensystems realtiv zur WCS Zeichnungsebene oder zum
zuletzt gezeichneten Objekt.
Die meisten der angebotenen Optionen machen erst während
der Arbeit in 3D Sinn (z.B. Side oder Front)

Was Type: Entscheidet über die Eingabeform der Koordianten,
karthesisch oder polar. Je nach Einstellung ändert sich das
Erscheinungsbild von Cursor und AccuDraw Fenster.

Rectangular: Karthesische Koordinateneingabe (default). Besonders für das Arbeiten mit fixen
Punkten geeignet.

Polar: Polarkoordinaten: Besonders für das Arbeiten mit vorgegebenen Richtungen
oder fixen Längen geeignet.
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Shortcut Key - Ins

wie Tastatureingabe [?]

Was Listet alle Shortcuts, respektive Tastaturbefehle auf.
Die meisten Shortcuts steuern die relative Ausrichtung des Hilfskoordinatensystems zum
gezeichneten Objekt oder zum WCS.

Top: Grundriss Ansicht  ( [t] )
Front: Frontansicht ( [f] )
Side: Seitenansicht ( [s] )
View: Senkrecht zur Blickrichtung ( [v] )
Auxilliary: Selbstdefiniertes Hilfskoordinatensystem
Context: Senkrecht zum selektierten Objekt

Schlussbemerkungen zu AccuDraw

AccuDraw stellt eines der wichtigen Tools innerhalb von Microstation dar. Die Bedienung  bedarf
aber einiger Übung.
Ohne Routine und vorallem ohne AccuDraw, wird das Arbeiten (insbesondere in 3D) sehr kompli-
ziert. Nur durch den ständigne Gebrauch werden die verschiedenen Tastatur Befehle und immer
wiederkehrenden Klickfolgen zur Routine und somit MicroStation effizient einsetzbar
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SmartLine Dokumentation
SmartLines - sogenannte intelligente Linien, spielen beim Arbeiten mit MicroStation eine sehr wich-
tige Rolle. Sie können dazu benützt werden, komplexe Linien oder Flächen mit unterschiedlichen
Segmenten zu zeichnen. Dieses Tool ist dazu konzipiert worden, gleichzeitig mit AccuDraw ver-
wendet zu werden.

SmartLine zeichnen

wo Tools>Main>LinearElements

was Nachdem Sie den Befehl "Place SmartLine" angewählt haben, klicken Sie mit der linken
Maustaste in die Mitte Ihres Arbeitsfensters und zeichnen unter Verwendung von
AccuDraw eine 10 Einheiten lange horizontale Linie.

bem Verschieben Sie den Mauszeiger so, dass im AccuDraw Window das X-Textfeld aktiviert wird. Geben Sie dort den Wert 10 ein.
Nun ist dieser Wert "gelockt". Wenn Sie die Maus bewegen, können Sie feststellen, dass nur noch Punkte angewählt werden,
die dem definierten Parameter entsprechen. Plazieren Sie den Mauszeiger so, dass ein horizontales RubberBand erscheint und
selektieren Sie den Punkt, indem Sie auf die linke Maustaste klicken.

Achten sie darauf, dass Sie während dem Zeichnen  folgende Einstellungen im SmartLine
Settings Window haben:

Segment Type: Linear
Vertex Type: Sharp
Join Elements: on

Ohne den Befehl mit der rechten Maustaste abzuschliessen, ergänzen Sie nun die eben
gezeichnete Linie zu einem Quadrat. Achten Sie darauf, dass Sie die Funktion Place
SmartLine nicht mit der rechten Maustaste abbrechen .

bem Beim zeichnen einer SmartLine haben sie mit der Option Join Elements, die Möglichkeit zu entscheiden, ob MicroStation die
einzelnen Linien zu einem einzigen Objekt verbindet, oder jedes Segment einzeln betrachtet.

SmartLines Settings

Während dem arbeiten mit SmartLines stehen immer verschiedene Optionen zur Verfügung, mit
denen das Verhalten und Aussehen der einzelnen Segmente bestimmt werden kann.
Diese Einstellungen werden in der SmartLine Settings-Toolbox definiert.

Segment Type
Lines, erzeugt eine gerade Linie.
Arc, stellt einen Kreis, resp. einen Kreisbogen dar.
Vertex Type
Sharp erzeugt einen scharf-gezeichneten Eckpunkt.
Rounded, der "scharfe" Eckpunkt wird durch einen
Kreisbogen ersetzt.
Chamfer, der Eckpunkt wird mit einer abgeschrägten
Kante dargestellt.
JoinElements, verbindet die einzelnen Linien zu einem Objekt

bem Alle diese Settings können während dem Arbeiten umgestellt werden - man braucht dazu den Befehl nicht abzubrechen.
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Mit SmartLine einen Arc zeichnen

wo SmartLine Settings-Dialogebox
wie Stellen Sie Segment Type auf Arc ein und deaktivieren Sie die Option JoinElements. Selek-

tieren Sie nun einen Eckpunkt des Quadrates mit der mittleren Maustaste und bestätigen
den vorgeschlagenen Tentativepoint mit einem Links-klick.
MicroStation fragt nun nach dem Zentrum des zu zeichnenden Kreises. Geben Sie mit
Hilfe von AccuDraw die Mitte einer Seitenkante als Zentrum des Arcs an.

Der nächste Punkt nach dem MS verlangt, ist der Endpunkt des Kreisbogens (die nächste
Ecke des Quadrates). Fahren Sie so weiter, bis das äussere Quadrat von vier Halbkreisen
umgeben ist.
Schliessen Sie den Befehl mit der rechten Maustaste ab.

Move Parallel

Erstellen Sie mit der Funktion MoveParalelle eine Kopie im Inneren des eben gezeichneten Quadra-
tes mit einem Abstand von 1 Einheit.

wo Tools>Main>Manipulate

wie Stellen Sie in der Tool Settingsbox eine Distanz von 1 ein und aktivieren die Option Make
Copy. Wählen Sie das Quadrat mit der mittleren Maustaste an und bestätigen die Aus-
wahl mit der linken Taste.
Nun erscheint ein normaler AccuDraw Cursor, mit dem die Richtung bestimmt wird , in
der das Objekt verschoben, resp. kopiert werden soll. Geben Sie die Richtung mit der
Maus an und klicken Sie auf die linke Taste.

bem Es kann auch eine Kopie des selektierten Objektes durch einen beliebigen Punkt erstellt werden, indem in der Tool-Settings-Box
der Distanz-Wert nicht gesetzt wird.

was Verfahren Sie mit den vier Kreisbögen gleich wie mit dem Quadrat und geben Sie dabei
auch die gleiche Verschiebungsrichtung an (nach innen).

bem Da wir vorhin die Option JoinElements abgeschaltet haben, muss der Befehl MoveParallel für jeden Kreisbogen einzeln
angewendet werden.

Trim Elements

Mit dieser Funktion können Sie ein Element oder eine Serie von Elementen auf deren Schnittpunkte
mit anderen Elementen kürzen.Es spielt dabei keine Rolle, ob die angewählten Elemente lines, arcs,
curves, shapes oder ellipses sind.
Bei diesem Schritt sollen die Eckpunkte des äusseren Quadrates "weggeschnitten" werden. Dafür
müssen die vier inneren Kreisbögen vorselektiert werden.

wo Main Toolbox, ElementSelection

was Damit man gleichzeitig mehrere "cutting elements" verwenden kann, müssen diese beim
Aufruf der Funktion vorselektiert sein. Klicken Sie dafür auf alle inneren Kreisbögen, bei
gleichzeitig gedrückter ctrl-Taste.

wo Tools>Main>Modify
was Klicken Sie auf das Icon für Trim Elements.

Da Sie bereits die cutting elements definiert haben, brauchen Sie nur noch auf die
Eckpunkte des äusseren Quadrates  (mit der linken Maustaste) und zum Beenden der
Funktion in den Hintergrund des Arbeitsfensters zu klicken.

bem Es gibt noch andere Befehle, mit denen man Linien kürzen oder verlängern kann. Sie finden diese gleich neben dem eben
benützten Icon. Probieren Sie die einzelnen Tools aus und versuchen Sie deren Arbeitsweise zu verstehen.
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Levels Dokumentation
MS verfügt über 63 Levels (sonst oft Layers genannt). Die Levels sind nummeriert. Jeder Level kann
unabhängig sichtbar oder unsichtbar geschaltet werden. Der Status der Levels ist individuell für je-
des Zeichnungsfenster bestimmbar.

Level einstellen

was Die Einstellung der Levels für die verschiedenen Viewports
wo "Settings" > "Level"> "Display". Es erscheint die Dialogbox

View Levels
wie sichtbar schalten:

Durch Anklicken eines weissen Feldes wird dieses schwarz
und somit als sichtbar definiert (+ Apply drücken).
unsichtbar schalten:
Durch Anklicken eines schwarzen Felds wird dieses weiss
und somit als unsichtbar definiert (+ Apply drücken).
aktive schalten:
Durch Doppelkick auf ein Feld wird dieses als aktiver Level
bestimmt. Der aktive Level ist immer sichtbar.

was View Number bestimmt, für welchen ViewPort die ge-
machten Einstellungen gelten sollen.

APPLY bestätigt die Êingaben und stellt den selektierten Viewport mit den neuen Einstel-
lungen dar.

bem Diese Einstellungen beziehen sich nicht auf die Elemente der Levels, sondern nur auf deren Sichtbarkeit innerhalb der
ausgewählten Viewports.

Level wechseln

was Um die Zugehörigkeit eines bestimmten Zeichnungselements zu einem bestimmten
Level zu verändern, müssen Sie das entsprechende Element selektieren (mit dem Pfeil-
werkzeug).

wo Oben links im MS Fenster findet sich neben dem Icon für die Farbe die Nummer des
aktiven Levels.

was Hier kann in verkürzter Form der aktive Level einsgestellt
werden.
Wenn zur Zeit der Wahl ein oder mehrere Elemente
selektiert waren, werden diese auf den entsprechenden
Layer gestellt.

bem Beachten Sie, dass auf diese Weise der Ziellevel immer auch als aktiver Level
gewählt wird. Da der aktive Level immer sichtbar ist, verändert sich ersteinmal
nicht, wenn man ein Element auf einen unsichtbaren Level stellt, da dieser
gleichzeitig aktiv und somit sichbar wird.

Alternativ kann der Level eines Elements auch über die Toolbox "Change Elements
Attributes" (Main Toolbox)eingestellt werden.


